
Computer Organization and Architecture
COSC 2425

Lecture – 8

Sept 14th , 2022

Acknowledgement: Slides from Edgar Gabriel & Kevin Long



Chapter 2

Instructions: Language of the Computer



LEGv8: Signed and Unsigned Numbers

• LEGv8: 64 bit double word representation.

• Example Representation: 11𝑡𝑒𝑛 = 1101𝑡𝑤𝑜

00000000 00000000 00000000 00000000 00000000 00000000 00000000 00001101
63 0

Least significant bitMost significant bit

Review



LEGv8: Unsigned Numbers

• LEGv8: 64 bit double word representation.

– Can represent 264 different patterns.

• Numbers range from [0, 264 − 1](18,446,774,073,709,551,615𝑡𝑒𝑛)

Review



LEGv8: Signed Numbers
• LEGv8: 64 bit double word 2’s complement representation.

Positive
Have 0 in most 
significant bit

Negative
Have 1 in most 
significant bit

Sign bit

Review



LEGv8: Signed Numbers
• LEGv8: 64 bit double word 2’s complement representation.

• Positive half range:

– [0 𝑡𝑜 9,223,372,036,854,775,807𝑡𝑒𝑛]

• Negative half

– [−1 𝑡𝑜 − 9,223,372,036,854,775,808𝑡𝑒𝑛]

Review



Representing Instructions

• Instructions are encoded in binary
– Called machine code

• LEGv8 instructions
– Encoded as 32-bit instruction words

– Different formats exists (but a small number)
• R-Type ➔Arithmetic

• D-Type ➔ Data transfer

• I-Type ➔ Immediate

• …

– Small number of formats encoding operation code (opcode), register numbers, …

– Regularity!

Review



LEGv8 R-format Instructions

• Instruction fields

– opcode: operation code

– Rm: the second register source operand

– shamt: shift amount (00000 for now)

– Rn: the first register source operand

– Rd: the register destination

opcode Rm shamt Rn Rd

11 bits 5 bits 6 bits 5 bits 5 bits

25=32 i.e 5 bits required to 
distinguish 32 Registers

Review



R-format Example

ADD X9,X20,X21

1112ten 21ten 0ten 20ten 9ten

10001011000two 10101two 000000two 10100two 01001two

1000 1011 0001 0101 0000 0010 1000 1001two =

8B15028916

opcode Rm shamt Rn Rd

11 bits 5 bits 6 bits 5 bits 5 bits

Review



Different format for Data Transfer (D-Type)

• Design Principle 3: Good design demands good compromises
– Different formats complicate decoding, but allow 32-bit instructions uniformly

– Keep formats as similar as possible

Review



LEGv8 D-format Instructions

• Load/store instructions
– Rn:  base register

– address:  constant offset from contents of base register (+/- 32 
doublewords)

– Rt: destination (load) or source (store) register number

opcode op2 Rn Rt

11 bits 9 bits 2 bits 5 bits 5 bits

address

Review



Example: D-Type

𝐿𝐷𝑈𝑅 𝑋9, [𝑋22, #𝟔𝟒]

opcode op2 Rn Rt

11 bits 9 bits 2 bits 5 bits 5 bits

address

1986 0 22 9

11 bits 9 bits 2 bits 5 bits 5 bits

64

Review



LEGv8 I-format Instructions

• Immediate instructions
– Rn:  source register

– Rd:  destination register

• Immediate field is zero-extended

opcode Rn Rd

10 bits 12 bits 5 bits 5 bits

immediate

Review



Example

𝐴 30 = ℎ + 𝐴 30 + 1

Base address of A stored in X10, h stored in X21

LEGv8 Assembly code:
LDUR X9, [X10, #240]
ADD X9, X21, X9
ADDI X9 ,X9, #1
STUR X9, [X10, #240]

Machine Language in Decimal:

Review



Example
𝐴 30 = ℎ + 𝐴 30 + 1

Review



Logical Operations
• Instructions for bitwise manipulation

Operation C Java LEGv8

Shift left << << LSL

Shift right >> >> LSR

Bit-by-bit AND & & AND, ANDI

Bit-by-bit OR | | OR, ORI

Bit-by-bit NOT ~ ~ EOR, EORI

◼ Operate on bits/bytes more useful than on words

◼ Examine characters (8 bits) within a word

◼ Useful for extracting and inserting groups of bits in a word

Shifts

Review



Chapter 2 — Instructions: 

Language of the Computer — 17

Shift Operations

• Use R- format
• shamt: how many positions to shift 
• Shift left logical

– Shift left and fill with 0 bits
– LSL Logical shift left

• Shift right logical
– Shift right and fill with 0 bits
– LSR Logical shift right

opcode Rm shamt Rn Rd

11 bits 5 bits 6 bits 5 bits 5 bits

Review



Example LSL

𝐿𝑆𝐿 𝑋11, 𝑋19, #4// 𝑠ℎ𝑖𝑓𝑡 4 𝑏𝑖𝑡𝑠 𝑡𝑜 𝑙𝑒𝑓𝑡

144𝑡𝑒𝑛 = 9𝑡𝑒𝑛 ∗ 2
4

Left Shift by i bits multiplies by 2i

Review



Logical Operations
• Instructions for bitwise manipulation

Operation C Java LEGv8

Shift left << << LSL

Shift right >> >> LSR

Bit-by-bit AND & & AND, ANDI

Bit-by-bit OR | | OR, ORI

Bit-by-bit NOT ~ ~ EOR, EORI

◼ Operate on bits/bytes more useful than on words

◼ Examine characters (8 bits) within a word

◼ Useful for extracting and inserting groups of bits in a word

Review



AND Operations
• Useful to mask bits in a word

– Select some bits, clear others to 0

AND X9,X10,X11

00000000 00000000 00000000 00000000 00000000 00000000 00001101 11000000X10

X11

X9

00000000 00000000 00000000 00000000 00000000 00000000 00111100 00000000

00000000 00000000 00000000 00000000 00000000 00000000 00001100 00000000

Review



OR Operations
• Useful to include bits in a word

– Set some bits to 1, leave others unchanged

ORR X9,X10,X11

00000000 00000000 00000000 00000000 00000000 00000000 00001101 11000000X10

X11

X9

00000000 00000000 00000000 00000000 00000000 00000000 00111100 00000000

00000000 00000000 00000000 00000000 00000000 00000000 00111101 11000000

Review



EOR Operations
• Exclusive OR instead of NOT

• Differencing operation
– Set some bits to 1, leave others unchanged

EOR X9,X10,X12  // NOT operation

00000000 00000000 00000000 00000000 00000000 00000000 00001101  11000000X10

X12

X9

11111111    11111111  11111111   11111111   11111111   11111111   11111111   11111111

11111111    11111111  11111111   11111111   11111111   11111111   11110010  00111111

Review



• LEGv8 Code: ?

C code:

if ( i==j ) 

f = g+h;

else 

f = g-h;



Instructions for Making Decisions

• Define Labels for instructions.

• LEGv8 Code:

L1: ADD X9, X21, X9

• Labels are only for Assembly language

• Assembler changes them to address in machine code

Label

Review



Instructions for Making Decisions

• Define Labels for instructions.

• LEGv8 Code:

L1: ADD X9, X21, X9

• Unconditional Branch: Instruct computer to branch to label

• B – branch to label

• LEGv8 Code:

𝐵 𝐿1 // Branch to statement with label L1

Review



Instructions for Making Decisions

• Define Labels for instructions.
• LEGv8 Code:

L1: ADD X9, X21, X9

• Instruct computer to branch to instruction using the label if some 
condition is satisfied. 

• CBZ – compare and branch if zero
• CBNZ – compare and branch if not zero
• LEGv8 Code:

𝐶𝐵𝑍 𝑟𝑒𝑔𝑖𝑠𝑡𝑒𝑟, 𝐿1 // if (register == 0) branch to instruction labeled L1;

𝐶𝐵𝑁𝑍 𝑟𝑒𝑔𝑖𝑠𝑡𝑒𝑟, 𝐿1 // if (register != 0) branch to instruction labeled L1;

Review



Example: Compiling If Statements
• C code:

if ( i==j ) 

f = g+h;

else 

f = g-h;

– i, j in X22, X23,

– f, g, h, in X19, X20, X21

• Compiled LEGv8 code:

X9 will be zero if i=j

Review



Example: Compiling If Statements
• C code:

if ( i==j ) 

f = g+h;

else 

f = g-h;

– i, j in X22, X23,

– f, g, h, in X19, X20, X21
• Compiled LEGv8 code:

SUB X9,X22,X23

CBNZ X9,Else

ADD X19,X20,X21

B Exit

Else: SUB X19,X20,x21

Exit: …

X9 will be zero if i=j

Review



Instructions

Type Name

Arithmetic ADD, SUB, MUL

Data transfer LDUR, STUR

Arithmetic Immediate ADDI, SUBI

Logical Operations LSL, LSR, AND, ORR, EOR

Branches B, CBZ, CBNZ



Instructions

Type Name

Arithmetic ADD, SUB, MUL

Data transfer LDUR, STUR

Arithmetic Immediate ADDI, SUBI, ANDI, ORRI, EORI

Logical Operations LSL, LSR, AND, ORR, EOR

Branches B, CBZ, CBNZ



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
?



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Address to access Save[i]

Loop I (X22) Address

0 0 ?



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) Address

0 0 X25

1 1 X25+8

Address to access Save[i]



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) Address

0 0 X25

1 1 X25+8

2 2 X25+2*8

3 3 X25+3*8

Address to access Save[i]



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) X10 Address

0 0 0*8 X25+X10

1 1 1*8 X25+X10

2 2 2*8 X25+X10

3 3 3*8 X25+X10

Address to access Save[i]



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) X10 Address

0 0 0*8 X25+X10

1 1 1*8 X25+X10

2 2 2*8 X25+X10

3 3 3*8 X25+X10

Address to access Save[i]



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) X10 Address

0 0 0*8 X25+X10

1 1 1*8 X25+X10

2 2 2*8 X25+X10

3 3 3*8 X25+X10

Address to access Save[i]



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) X10 Address

0 0 0*8 X25+X10

1 1 1*8 X25+X10

2 2 2*8 X25+X10

3 3 3*8 X25+X10

Address to access Save[i]



Compiling Loop Statements

• C code:

while (True)

k = k + save[i] 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

ADD   X24, X24, X9

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Loop I (X22) X10 Address

0 0 0*8 X25+X10

1 1 1*8 X25+X10

2 2 2*8 X25+X10

3 3 3*8 X25+X10

Address to access Save[i]



Compiling Loop Statements

• C code:

while (save[i] == k) 

i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
?



Compiling Loop Statements

• C code:

while (save[i] == k) i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

SUB   X11,X9,X24 // X11 = save[i] - k

CBNZ  X11,Exit     // conditional branch

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Exit: …



Compiling Loop Statements

• C code:

while (save[i] == k) i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   // X10 = i*23

ADD   X10,X10,X25 // Address to load save[i]

LDUR  X9,[X10,#0] // load save[i]

SUB   X11,X9,X24 // X11 = save[i] - k

CBNZ  X11,Exit     // conditional branch

ADDI  X22,X22,#1 // i += 1

B     Loop // uncond. branch

Exit: …



Basic Blocks
• A basic block is a sequence of instructions with

– No embedded branches (except at end)

– No branch targets (except at beginning)

◼ A compiler identifies basic 

blocks for optimization

◼ An advanced processor 

can accelerate execution 

of basic blocks



Condition Codes or Flags
• C code:

if ( i==j ) 

f = g+h;

else 

f = g-h;

– i, j in X22, X23,

– f, g, h, in X19, X20, X21
• Compiled LEGv8 code:

SUB X9,X22,X23

CBNZ X9,Else

ADD X19,X20,X21

B Exit

Else: SUB X19,X20,x21

Exit: …

• C code:

while (save[i] == k) i += 1;

– i in x22, k in x24, address of save in x25

• Compiled LEGv8 code:
Loop: LSL   X10,X22,#3   

ADD   X10,X10,X25

LDUR  X9,[X10,#0]

SUB   X11,X9,X24

CBNZ  X11,Exit

ADDI  X22,X22,#1

B     Loop

Exit: …



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( i==j )

..

SUB X9,i,j   // Subtract

CBNZ X9,Else // Check if zero or not 



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( I < j )

..

?



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( I < j )

..

SUB X9, i, j

//check if –ve



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( I < j )

..

SUB X9, i, j

//check if –ve

How to check if X9 is negative?



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( I < j )

..

SUB X9, i, j

//check if –ve

How to check if X9 is negative?

Depends on if i,j are signed or 

unsigned.



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( I < j )

..

SUB X9, i, j

//check if –ve

How to check if X9 is negative?

Depends on if i,j are signed or 

unsigned.

If signed, check the first bit (if it 

is 1 it is negative, else positive)



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( I < j )

..

SUB X9, i, j

//check if –ve

How to check if X9 is negative?

Depends on if i,j are signed or 

unsigned.

If signed, check the first bit (if it 

is 1 it is negative, else positive).

If unsigned, numbers are borrowed all 

the way to the significant bit. 



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( i > j )

..

SUB X9, i, j

//check if +ve

Requires too much logic.



Other Comparison

< Less than

≤ Less than or equal

> Greater than

≥ Greater than or equal

= Equal

! = Not equal

if ( i > j )

..

SUB X9, i, j

//check if +ve

Requires too much logic.

All these conditions can be checked by 

setting four flags, called Condition 

Codes



Condition code

• LEGv8 provides four added bits called 
condition codes.

• Some arithmetic instructions can 
optionally set these flags based on the 
result of the operation.

• Then the branch (B) instruction can check 
these bits to do comparisons. 

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒(N)

𝑍𝑒𝑟𝑜 (Z)

𝑂𝑣𝑒𝑟𝑓𝑙𝑜𝑤 (V)

𝐶𝑎𝑟𝑟𝑦 (C)

Condition codes/flags



Example SUBS : Subtract and Set Flag

• LEGv8 provides set flag variants for SUB

Condition codes/flags

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒(N)

𝑍𝑒𝑟𝑜 (Z)

𝑂𝑣𝑒𝑟𝑓𝑙𝑜𝑤 (V)

𝐶𝑎𝑟𝑟𝑦 (C)



Example SUBS : Subtract and Set Flag

• LEGv8 provides set flag variants for SUB

𝐴𝑠𝑠𝑢𝑚𝑒 𝑖 = +9 , j = +10 are signed integers, 
and store in X1, and X2 respectively

To do the comparison
𝐼𝑓 𝑖 < 𝑗

…

Condition codes/flags

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒(N)

𝑍𝑒𝑟𝑜 (Z)

𝑂𝑣𝑒𝑟𝑓𝑙𝑜𝑤 (V)

𝐶𝑎𝑟𝑟𝑦 (C)



Example SUBS : Subtract and Set Flag

• LEGv8 provides set flag variants for SUB

𝐴𝑠𝑠𝑢𝑚𝑒 𝑖 = +9 , j = +10 are signed integers, 
and store in X1, and X2 respectively

To do the comparison
𝐼𝑓 𝑖 < 𝑗

…

LEGv8 code:
𝑆𝑈𝐵𝑆 𝑋1, 𝑋1, 𝑋2

Condition codes/flags

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒(N)

𝑍𝑒𝑟𝑜 (Z)

𝑂𝑣𝑒𝑟𝑓𝑙𝑜𝑤 (V)

𝐶𝑎𝑟𝑟𝑦 (C)



Example SUBS : Subtract and Set Flag

• LEGv8 provides set flag variants for SUB

𝐴𝑠𝑠𝑢𝑚𝑒 𝑖 = +9 , j = +10 are signed integers, 
and store in X1, and X2 respectively

To do the comparison
𝐼𝑓 𝑖 < 𝑗

…

LEGv8 code:
𝑆𝑈𝐵𝑆 𝑋1, 𝑋1, 𝑋2

Condition codes/flags

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒(N) 1

𝑍𝑒𝑟𝑜 (Z)

𝑂𝑣𝑒𝑟𝑓𝑙𝑜𝑤 (V)

𝐶𝑎𝑟𝑟𝑦 (C)Result is -1
The N flag is 
set



Example SUBS : Subtract and Set Flag

• LEGv8 provides set flag variants for SUB

𝐴𝑠𝑠𝑢𝑚𝑒 𝑖 = +9 , j = +10 are signed integers, and 
store in X1, and X2 respectively

To do the comparison
𝐼𝑓 𝑖 < 𝑗

…

LEGv8 code:
𝑆𝑈𝐵𝑆 𝑋1, 𝑋1, 𝑋2

// 𝐵𝑟𝑎𝑛𝑐ℎ 𝑖𝑓 𝑁 𝑓𝑙𝑎𝑔 𝑖𝑠 𝑠𝑒𝑡

Condition codes/flags

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒(N) 1

𝑍𝑒𝑟𝑜 (Z)

𝑂𝑣𝑒𝑟𝑓𝑙𝑜𝑤 (V)

𝐶𝑎𝑟𝑟𝑦 (C)

Conditional branches use 
these codes to do 
comparisons



Four Condition Flags

–negative (N):  result had 1 in MSB

– zero (Z):  result was 0

–overflow (V):  result overflowed

– carry (C):  result had carryout from MSB



Set Flag Instructions
Arithmetic Instruction With Set Flag Option

(Suffix S)
Description

ADD ADDS Add and set condition flag

ADDI ADDIS Add immediate and set condition flag

SUB SUBS Subtract and set condition flag

SUBI SUBIS Subtract immediate and set condition flag

AND ANDS AND and set condition flag

ANDI ANDIS AND immediate and set condition flag



Conditional Branches that use Flags

• Format ➔ B.cond
• Use subtract to set flags and then conditionally branch

– B.EQ 
– B.NE
– B.LT (less than, signed) 
– B.LO (less than, unsigned)
– B.LE (less than or equal, signed) 
– B.LS (less than or equal, unsigned)
– B.GT (greater than, signed) 
– B.HI (greater than, unsigned)
– B.GE (greater than or equal, signed),
– B.HS (greater than or equal, unsigned)



Conditional Branches that use Flags

• Format ➔ B.cond

• Use subtract to set flags and then conditionally branch



Conditional Example

if (a > b) 

a += 1;

– a in X22, b in X23

LEGv8 Code:

?



Conditional Example

if (a > b) 

a += 1;

– a in X22, b in X23

LEGv8 Code:

SUBS X9,X22,X23  // use subtract to make comparison

B.LTE Exit               // conditional branch

ADDI X22,X22,#1

Exit:



Instructions

Type Name

Arithmetic ADD, SUB, MUL

Data transfer LDUR, STUR

Arithmetic Immediate ADDI, SUBI, ORRI, ANDI, EORI

Logical Operations LSL, LSR, AND, ORR, EOR

Branches B, CBZ, CBNZ, B.Cond

Set Condition Flag ADDS, ADDIS, SUBS, SUBIS, ANDS, ANDIS



Supporting Procedures in Computer Hardware

• Procedure or functions:

– Structure programs

– Easy to read

– Reusable code



C Example



C Example

Has parameters

Has return value



C Example

Callee

Caller



Steps in Executing a Procedure

X0 

X1

X2

Computer

…

Op2

Op3

Op1

XZR

X30



Steps in Executing a Procedure

X0 

X1

X2

Computer

…

Op1

XZR

X30

Initially main (Caller) has control of the computer.

Op2

Op3



Steps in Executing a Procedure

X0 (a)

X1 (b)

X2

Computer

…

Op1

XZR

X30

1. Caller puts parameters in registers for the procedure 

Op2

Op3



Steps in Executing a Procedure

X0 (a)

X1 (b)

X2

Computer

…

Op1

XZR

X30(LR) RAddr

1. Caller puts parameters in registers for the procedure 
1. Specify a return address

Op2

Op3



What Registers used?

• X0 – X7: procedure arguments/results

• X30 (LR): link register (return address)
– Also called as program counter (PC)

– Program Counter: Contains the address of the current instruction



Steps in Executing a Procedure

X2

Computer

…

Op1

XZR

2. Transfer control to callee

X0 (a)

X1 (b)

X30(LR) RAddr

Op2

Op3



Steps in Executing a Procedure

X2

Computer

…

Op1

XZR

3. Acquire storage resources need for procedure

X0 (a)

X1 (b)

X30(LR) RAddr

Op2

Op3



Steps in Executing a Procedure

X2

Computer

…

Op1

XZR

4. Perform Task

X0 (a)

X1 (b)

X30(LR) RAddr

Op2

Op3



Steps in Executing a Procedure

X2 (results)

Computer

…

Op1

XZR

5. Put results in a register

X0 (a)

X1 (b)

X30(LR) RAddr

Op2

Op3



What Registers used?

• X0 – X7: procedure arguments/results

• X30 (LR): link register (return address) 
– Also called as program counter (PC)

– Program Counter: Contains the address of the current instruction



Steps in Executing a Procedure

X2 (results)

Computer

…

Op1

XZR

6. Return control to Caller

X0 (a)

X1 (b)

X30(LR) RAddr

Op2

Op3



Procedure Calling

• Steps required

1. Place parameters in registers X0 to X7

2. Transfer control to procedure

3. Acquire storage for procedure

4. Perform procedure’s operations

5. Place result in register for caller

6. Return to place of call (address in X30)



Procedure Instructions



Steps in Executing a Procedure

X0 (a)

X1 (b)

X2

Computer

…

Op1

XZR

X30(LR) RAddr

1. Caller puts parameters in registers for the procedure 
1. Specify a return address

BL ProcedureLabel

Op2

Op3



Procedure Instructions

• Procedure call: jump and link
BL ProcedureLabel

– Address of following instruction put in X30 (LR)
• Actually PC + 4 (32 bit instruction)

– Jumps to target address



Steps in Executing a Procedure

X2 (results)

Computer

…

Op1

XZR

6. Return control to Caller

X0 (a)

X1 (b)

X30(LR) RAddr
BR LR

Op2

Op3



Procedure Instructions

• Procedure call: jump and link
BL ProcedureLabel

– BL: Branch and Link Register 

– Address of following instruction put in X30 (LR)

– Jumps to target address

• Procedure return: jump register

BR LR

– BR: Branch Register 

– Copies LR to program counter



Instructions

Type Name

Arithmetic ADD, SUB, MUL

Data transfer LDUR, STUR

Arithmetic Immediate ADDI, SUBI, ORRI, ANDI, EORI

Logical Operations LSL, LSR, AND, ORR, EOR

Branches B, CBZ, CBNZ, B.Cond

Set Condition Flag ADDS, ADDIS, SUBS, SUBIS, ANDS, ANDIS

Procedure Instructions BR, BL



What if > 8 registers are needed by Callee?



What if > 8 registers are needed by Callee?



What if > 8 registers are needed by Callee?

X19 (c)

Computer

…

Op1

XZR

X0 (a)

X1 (b)

X30(LR) RAddr

Needs more registers?

Op2

Op3



What if > 8 registers are needed by Callee?

X19 (c)

Computer

…

Op1

XZR

X0 (a)

X1 (b)

X30(LR) RAddr

Op2

Op3



Spill and Restore Registers

1. Save variable c to memory from register

1. A register spill is said to occur

2. Finish executing procedure

3. Restore value of variable c from memory to Previous location 
(X19)



Spill and Restore Registers

1. Save variable c to memory from register

1. A register spill is said to occur

2. Finish executing procedure

3. Restore value of variable c from memory to Previous location 
(X19)

One register contains memory location to store the values



Spill and Restore Registers

1. Save variable c to memory from register

1. A register spill is said to occur

2. Finish executing procedure

3. Restore value of variable c from memory to Previous location 
(X19)

One register contains memory location to store the values

The ideal structure to store values is a Stack



What Registers used?

• X0 – X7: procedure arguments/results

• X28 (SP): stack pointer (address of the most recently allocated stack)

• X30 (LR): link register (return address) 
– Also called as program counter (PC)



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)

• Goes from High to low for historic 
reasons



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)

LEGv8 Code:

Make room for three items



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)

LEGv8 Code:
// 𝑀𝑎𝑘𝑒 𝑟𝑜𝑜𝑚 𝑓𝑜𝑟 𝑡ℎ𝑟𝑒𝑒 𝑖𝑡𝑒𝑚𝑠
𝑆𝑈𝐵𝐼 𝑆𝑃, 𝑆𝑃, #24



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)

LEGv8 Code:
𝑆𝑈𝐵𝐼 𝑆𝑃, 𝑆𝑃, #24 // 𝑀𝑎𝑘𝑒 𝑟𝑜𝑜𝑚 𝑓𝑜𝑟 𝑡ℎ𝑟𝑒𝑒 𝑖𝑡𝑒𝑚𝑠

𝑆𝑇𝑈𝑅 𝑋10, 𝑆𝑃, #16 //𝑆𝑝𝑖𝑙𝑙 𝑋10
(PUSH)



Spilling to stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)

LEGv8 Code:
𝑆𝑈𝐵𝐼 𝑆𝑃, 𝑆𝑃, #24 // 𝑀𝑎𝑘𝑒 𝑟𝑜𝑜𝑚 𝑓𝑜𝑟 𝑡ℎ𝑟𝑒𝑒 𝑖𝑡𝑒𝑚𝑠
𝑆𝑇𝑈𝑅 𝑋10, 𝑆𝑃, #16 //𝑆𝑝𝑖𝑙𝑙 𝑋10

𝑆𝑇𝑈𝑅 𝑋9, 𝑆𝑃, #8 //𝑆𝑝𝑖𝑙𝑙 𝑋9

𝑆𝑇𝑈𝑅 𝑋19, 𝑆𝑃, #0 //𝑆𝑝𝑖𝑙𝑙 𝑋19



Restore from Stack

• To spill registers (X10, X9, X19) on to 
the stack 

• Address of stack is save in X28 (SP)

LEGv8 Code:
𝐿𝐷𝑈𝑅 𝑋19, 𝑆𝑃, #0 //𝑆𝑝𝑖𝑙𝑙 𝑋19 (POP)

𝐿𝐷𝑈𝑅 𝑋9, 𝑆𝑃, #8 //𝑆𝑝𝑖𝑙𝑙 𝑋9
𝐿𝐷𝑈𝑅 𝑋10, 𝑆𝑃, #16 //𝑆𝑝𝑖𝑙𝑙 𝑋10

𝐴𝐷𝐷𝐼 𝑆𝑃, 𝑆𝑃, #24 // 𝑀𝑎𝑘𝑒 𝑟𝑜𝑜𝑚 𝑓𝑜𝑟 𝑡ℎ𝑟𝑒𝑒 𝑖𝑡𝑒𝑚𝑠


